Windows 3.1

The OLE outline

Panicos Georghiades and Gabriel Jacobs show you what to do if your Windows installation
gets corrupted and your programs don’t work. Chances are, it’s OLE registration trouble.

t’s not too uncommon for a

Windows installation to become

corrupted to the point where
certain programs do not work at all. One of
the first things to investigate is the possibility
of a corrupted registration database. If you
suspect this (see “Rebuilding the REG.DAT”
for reasons why) you may choose to make
a fresh installation of Windows and all your
programs, as we have suggested in Paul
Cunliffe’s case (p263), or you could first try
to rebuild the registration database.

Program Manager and Object Linking

and Embedding (OLE) registration
information is stored in .REG files that are
used by the Registration Editor
(REGEDIT.EXE) to add information to the
registration database, REG.DAT.

REG.DAT contains information about file
associations and OLE objects. The
Windows 3.1 Setup program uses
REGEDIT.EXE to add default associations
for Paintbrush, Notepad and some other of
its programs and objects (like Packager,
Paintbrush, and Sound Recorder).

REG.DAT is not copied from the original
disks. Instead, it is built using
REGEDIT.EXE and the SETUP.REG file
(in the Windows\System sub-directory)
during setup.

A sign that the REG.DAT file may be
corrupted is one of the following messages:
e File Manager cannot open or print the
specified file. Start the application used to
create this file and open or print it from
there.
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File Manager
Right Once you register a REG file, you should
saying that the registration was successful

®

get a message

= Registration Info Editor

Information in CAWIN31\MPLAYER.REG has been successfully
registered in the registration database.

e There is no application associated with
this file. Choose Associate from the File
menu to create an association [only if you
know for a fact that there is an association}.
e There is a problem with REG.DAT. Delete
REG.DAT and restart Windows.

e Setup had a problem with REG.DAT,
SHELL.DLL or disk space.

e \Windows registration database program
is not valid.

e OLE server initialisation failed.

¢ \Windows registration database is not valid.

Rebuilding the REG.DAT
If your REG.DAT file has been deleted or
corrupted, you can rebuild using the
methods shown below.
m Building the original REG.DAT file for
applications that came with Windows:
To restore these defaults, first rename your
existing REG.DAT file (if there is one
present) before you try to rebuild it. We
assume that your Windows directory is on
drive C and is called WINDOWS.
1. Run Program Manager or File Manager.
2. From the File menu, choose Run.
3. In the dialog box, type the following:
regedit /u c:\windows\system\setup.reg
A message should appear, confirming
that the information has been registered.
The database now contains the original
registration information that was installed
with Windows.
4. Choose OK. At this point, you may have
to exit and restart Windows in order to see
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Windows 3.1

Paintbrush tips
Let’s face it, there are more powerful

Paint programs than Paintbrush, but it's = Paintbrush - [Untitled] I |
there, free, and many people use it. Here File Edit Yiew Text Options Help

are two useful tips. A +
1. To draw lines in Paintbrush that snap to % % N
45-degree increments, select the line tool
(not the brush), then hold down the Shift
key and draw. You’ll only be able to draw
vertical, horizontal and diagonal lines, but
it’s a useful thing to know (it saves you
struggling to keep the mouse still!). The
technique also works with other drawing
tools. To restrict yourself to vertical and
horizontal lines, select the brush tool
instead of the line tool.

2. If printouts from full-screen Paintbrush
images turn out to be miniature versions
of the actual image (just a couple of
inches or so), you have the Printer
Resolution checkbox selected in the File
Print dialog box. This makes Paintbrush
translate pixels on the screen to dpi (dots
per inch) on your printer. In other words, if
your image is 640 x 480 and you’re using *
an HP DeskJet that prints at 360dpi, your
image will be printed at 640/360 x
480/360 = 1.77 x 1.33in. Although this

/ AN

DRAW PERFECT DIAGONALS

AO[0[O]56 -
I EIEIENTS

Above To draw perfect diagonal lines in Paintbrush, use the
Shift-Key with the line tool

Quality — | Window

O Draft @ whole Left Uncheck the Use Printer Resolution box if you are getting
Wy = Cancel | minute printouts

@ Proof  Partial

setting will give you printouts with the highest resolution (no jagged
edges), you will need to work with very large image sizes to print
reasonable size images (1,800 x 1,800 pixels for a 5in x 5in print on a
printer with a 360dpi resolution). Images at this size or above may be
unmanageable if you don’t have lots of RAM; in these cases, you need

Humber of copies: EI Scaling:

[100_]*

B iUsge Printer Resolution;

to work with the Printer Resolution checkbox turned off.

the REG.DAT file displayed in File Manager.
When it is, execute the next step.

5. In File Manager, select the REG.DAT file
found in the Windows program directory,
then choose Associate from the File menu.
Associate files with extensions DAT and
REG with REGEDIT.EXE. When you
removed the old REG.DAT file, you also
removed your file associations list, therefore
you have to choose REGEDIT.EXE using
the Browse button.

6. Exit and restart Windows. After you have
created a new REG.DAT file or restored the
defaults, use the following steps to renew
the list of applications in the Associate
dialog box:

(@) In File Manager, choose Run from the
File menu.

(b) In the dialog box, type the following line:
regedit /u c:\windows\system\setup.reg
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m Rebuilding the REG.DAT file for other
applications:

For applications other than the Windows-
based programs included with Windows
3.1, the technique varies for rebuilding
REG.DAT. Some applications rebuild their
entries each time the application is started.
Others may register themselves only during
their setup processes.

If the application includes a REG file, you
can add that information to the registration
database in one of three ways.

1. Choose Merge Registration File from the
File menu in the Registration Information
Editor, then select the .REG file for the
application to be added to the database
and choose OK.

2. Use the same steps described above,
substituting the name of the .REG file.
Otherwise, consult the application’s

documentation, or contact the vendor of
the software for more information about
rebuilding the REG.DAT file.

3. Run Windows File Manager and double-
click the application’s .REG file.

If you need to rebuild the registration
database for all your applications, use the
following steps:

1. From the File menu in File Manager,
choose Search.

2. Search for *.REG from C:\. Ensure that
the Search All Sub-directories checkbox is
selected before you choose OK.

3. Run SETUP.REG by double-clicking the
file icon, or highlight it and press ENTER.
4. Run every other .REG file brought up by
the File Manager search.

So, a Happy New Year to all our
readers, and no (or at least, very few)
General Protection Faults!




Windows 3.1

Questions & Answers

My Windows 3.11 system seems
to be falling apart! It started a
week or two ago when | found it
impossible to launch applications by
clicking on an associated file in File
Manager. Since then, | have
encountered the following:
1. CorelDraw 3: Each time | create/edit
an object | get the message “Error
while performing an OLE request”,
although when | acknowledge this
message, it allows me to continue.
2. PhotoFinish: | cannot launch this. |
get the error message “OLE Instance
Init failed — please re-install program”.
3. Picture Publisher: Will not launch
and there is no error message.
4. WordStar version 2/Quattro Pro
version 6: When | update spreadsheet
data which has a link to a WordStar
document, | get the error message
“Internal WSWin Error” followed by
“Fatal Error 600e”.
| am beginning to see a pattern
emerge — OLE problems — but have
no idea how to correct them. Would it
be best to re-install Windows? And if
so, will it re-install over what is already
there, or do | have to uninstall it first?
Paul Cunliffe
Paul@sischem.telme.com
In terms of clearing whatever is
“bad” in your installation, yes, your
best bet is to make a fresh start and re-
install Windows and all your applications,
having first deleted what is there. This
takes time, but if you are only using the
applications mentioned above, it should
not take you more than a couple of hours.
There may be other ways to fix the
problem but you could spend a lot longer
trying — and possibly failing. But
remember, before you begin, make sure
that you have backed up your data.
However, there is one seemingly major
problem which can be fixed with a repair
job as opposed to a full re-installation of
Windows: in the main body of our column
we have covered what you can do when
you encounter corrupted registration files.

| have a 386/33SX with 8Mb RAM
Q and a 1Mb SVGA Trident card
running in full-resolution 256-colour
without problems under DOS 6.2.
| have recently attempted to run

SVGA via the Windows Setup, only to
find corrupted displays above 16-
colour VGA.

| had Trident drivers T800C and
T1024C installed and have recently
downloaded the latest drivers from
Trident for my T8900CL board, but the
problem remains.

| have decompressed my drive,
re-installed Windows and it is still the
same. Is this a memory conflict or a
missing SYSTEM.INI instruction?

Carolinelt@aol.com

A problem of this kind is

documented for the Windows 3.11
SVGA driver and Trident 1 MG cards, but
it refers to when switching from an
MSDOS full-screen mode to window
mode using the Alt-Return keys. The
solution is to update to newer drivers —
the specific Trident driver that corrects
this has a date of February 1994.

You can also try the general SVGA
drivers supplied by Microsoft in the
Windows Driver List (WDL) available from
the Microsoft web site. The relevant file is
SVGA.EXE. This supports most non-
accelerated SVGA display types at 640 x
480 in 256 colours, and 800 x 600 and
1024 x 768 in 256 colours using either
Small or Large fonts (five settings in total).

Your card — the Trident 8900C series
— is included in the supported list.
However, it is more than likely that your
problem may stem from a memory
conflict. Some graphics cards use
additional memory to enhance
performance. Windows detects most of
these cards and automatically excludes
the additional memory. But if it does not,
you can add the line below to the
[386enh] section of SYSTEM.INI:
emmexclude=C400-C7FF

This prevents Windows from scanning
the addresses C800:0000 through
CFFF:000F — the block that some VGA
cards use to enhance performance. If you
don’t want to exclude the whole memory
block, your card’s manual should show
what does need to be excluded.

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.co.uk
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Windows 3.1

Clean sweep

What can you do with an over-stuffed hard disk? Slim and trim, say Panicos Georghiades
and Gabriel Jacobs, but be careful what you shed. And, a-haunting we will go, with Win.ini.

| am unable to access Word

6.0 and my computer supplier

has suggested it may be due
to a corruption in my copy of Windows
3.11. The problem coincided with my
deletion of some dead files and loading
of new software (upgrading Claris 1 to
3.0). On attempting to open Word, the
initial result was that | got the message
“Application Error — Call to Undefined
Dynalink”. All other software including
Claris 3, Cheyenne Bitware fax, internet
access via Netscape 2.0 and all
Windows features still worked perfectly.

| deleted the Winword directory and

re-installed successfully, but the same
failure to access occurred. Deleting
Word via its uninstall facility invoked a
number of queries concerning the effect
on other programs dependent on Word
files: | accepted the deletions because,
as far as | know, | have no related
programs.

But on re-installing, the setup was not
successful because “While registering
OLE servers, Setup had a problem with
REG.DAT, SHELL.DLL or disk space”. As
aresult, the Word 6 icons failed to
appear on the Program Manager.

Access via Winword.exe in File
Manager brought up: “The Windows
registration database file is not valid.
You can correct it with Word’s Setup
Program”. Clicking on OK brought up the
Application Error, as before.

My supplier has suggested deleting
Windows 3.11 at the DOS prompt by
entering DELTREE C:\WINDOWS and
then re-installing it. | am reluctant to do
this because | believe a wholesale
reloading of software will be necessary.
My hardware is a 486DX2-66 with 8Mb
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LCommand Line:
|C:\WINDOWSKREGEDIT.EXE |

[] Run Minimized

= I The easy way to access all

your registration files

Cancel your hard disk, run
Scandisk, defragment
your hard disk, then re-
install Windows and all
your other software,

Browse. ..

RAM and a 251Mb hard disk with about
95Mb free. | have no files of my own in
the Windows or Winword directories.
Trevor Whatmore
trevorww@easynet.co.uk
The problem originates either from your
having deleted some “dead” files or
from having installed Claris 3.0. The error
“Call to Undefined Dynalink” can be caused
when Word tries to use a DLL file which is
either missing, damaged, or a different
version from the one it is expecting.

Claris 3.0 is listed in Microsoft
documentation as one of a number of
programs installing OLE components that
are older than those used by Microsoft
Office. It is likely to be any one or more of
the following files: OLE2CONV.DLL,
OLE2DISP.DLL, OLE2NLS.DLL,
COMPOBUJ.DLL, or STORAGE.DLL.

But when, during the Word uninstall
process, you accepted file deletions which
apparently were not in use by other
programs, useful files may have been
deleted. A clean start may not be such a
bad idea after all. When you have some free
time, backup all your personal data and
delete both the Windows and the Word
directory, as well as all the other directories
of all your software packages (because as
you rightly suggest, they will have to be re-
installed once Windows has a clean
installation). With DOS-only software left on

preferably in order of
their release (older software first, newer
software last).

Although this solution will take some
time (it could be as much as a whole day), it
will ensure that all unused files are deleted
both from the hard disk and your installation
settings. It should also result in some extra
hard disk space (we assume you were
trying to free some up by deleting “dead”
files in the first place).

As arule, we don’t recommend such
draconian measures. Unlike cleaning up
your house, computer clean-ups don’t
make your installation look better or cleaner.
They’re only needed when things stop
working. But unless you can be sure about
which files you deleted and have some way
of getting them back, we would suggest a
clean sweep, as it were. Cut your losses, is
our advice.

One more thing. When you’re running
uninstall routines and they ask you whether
you want to delete certain files which aren’t
being used, but could be used by other
programs, select the safest option and
leave them on the hard disk — there may
very well be other programs using them.
Also have a look at our panel, “Windows on
a diet” (opposite).

Q | am using Windows 3.11 with
Norton Desktop. A few months ago,
| ran a CD Serif Pub Suite. | did not keep

Windows 3.1

Windows on a diet

If you have a small hard disk, or lots of
programs and little space remaining, it’s
possible to slim down your Windows
installation. But what can and cannot be
deleted without getting into trouble? Before
we tell you, here are some vital statistics:
Windows installation space

Anorexic 2.5 to 5Mb
Skinny 5to 10Mb
Slim 15 to 25Mb

Office Sweet satiated 25 to 35Mb
Has been eating junk-food
and storing junk files Over 35Mb
Right, let’s go. Firstly, do not delete any
files while Windows is running. Delete any of
the following files from the command prompt:
that is, before you start Windows or after you
exit (not using the Windows DOS prompt):
1. EMM386.EXE (expanded memory
emulator) — if you don’t need to provide
EMM support for non-Windows applications
(i.e. if your Config.sys file doesn’t refer to it).
2. Files in the Windows\Temp directory —
assuming the PATH command in your
Autoexec.bat file, SET TEMP, is set to
that directory.

When finished selecting, choose OK_

Do not install

\ﬂ these files:
256-Color Wallpaper [5K)
Arcade Wallpaper (1K)
Arches Wallpaper [11K]
Argyle Wallpaper [1K)
Canyon MIDI Song (34K)
Cars Wallpaper [1K)
Castle Wallpaper [1K]
Chimes Sound [16K)

0 file(s) selected: 0 Bytes

To remove hiles, select files on the right, then choose Remove.

Honey Wallpaper [1K)
Add All > Leaves Wallpaper [15K)

Total Disk Space Required: 204 702 Bytes

3. Any files that start with the characters
~WOA or ~GRB.

4. A file named WIN386.SWP — temporary
Windows swap file.

While running Windows, you can also
delete any of the following by choosing the
Windows Setup icon in the Main Group, then
choosing Add/Remove Components from the
Options menu:

5. Any accessories you don’t use (such as
Paintbrush, Write, Calendar, Cardfile) with
their related .HLP and .DLL files.

6. Games:

® Reversi — Reversi.exe, Reversi.hlp

e Solitaire — Sol.exe, Sol.hip

® Hearts — Hearts.exe, Hearts.hlp

® Minesweeper — Winmine.exe, Winmine.hlp
7. Screensavers — .SCR extension.

8. Wallpapers, other images and sound files
— .BMP and .WAV extensions.

9. Readme files — often with .\WRI or .TXT
extensions, but be careful to delete only those
Readme files that you really do not want.
Have alook at what they contain first and be
careful not to delete any documents, images or
sounds you need (WRI, .TXT, .BMP, .WAV).

= Wallpapers, Misc.

To install files. select files on the left, then choose Add.

Cancel

Install these files
g on the hard dizk:

Chitz Wallpaper [20K)
Chord Sound [25K)
Ding Sound [12K)
Egypt Wallpaper [1K)
Flock wWallpaper [2K)

HE

Marble Wallpaper [27K] +

0 file(s) selected: 0 Bytes

If you need hard disk space, use the Add/Remove Components from the Options menu
of the SetUp icon in the Main Group to slim down your Windows installation

it on my PC but now | have entries in the
Embedding section of my Win.ini. They
are: “Type Plus = Serif Type Plus, Serif
Type Plus” and so on. | have tried
deleting the entries, but they haunt me
and won’t stay away.
Norman Lomas
normlomas@aol.com

section is included in WIN.INI to maintain
compatibility with Windows 3.0 and
Windows 3.0 applications. You do not say
what method you have used to delete the
entries. Delete again by running the
Registration Info Editor (REGEDIT.EXE) from
File or Program Manager.

Win.ini entries are added when you

install new software (including
hardware drivers) but sometimes also when
you run programs. Even if you delete the
entries, some programs just put them back
when you run them. The [embedding]

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.co.uk.
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Windows 3.1

Recording scssion

The Windows Recorder facility has nothing to do with video or sound; rather, for repetitive tasks,
its time-saving abilities could be invaluable. Panicos Georghiades and Gabriel Jacobs explain.

he computer is the ultimate
programmable automated
machine, and its keyboard and
mouse are multi-functional. The problem is
that we can end up with having to press
innumerable combinations of these
buttons whereas just one could do the job
of many. In other words, we could do with
a single piece of program code that
manipulates other programs: a computer
using a computer.

Such programs do exist and many are
free, like the macro recording facilities in
word processors. Windows has its own
under-used Recorder accessory. Despite
the camcorder icon for this accessory,
which to many users may be misleading,
this program has nothing to do with
recording video or sound (there’s a
separate Sound Recorder accessory).

The Recorder is not a full-blown facility
as found in Excel or Word for Windows: it
lacks a programming language. In other
words, you can’t set up a command script.
It merely records your moves and you
cannot subsequently edit the result, so if
you make a mistake you have no option but
to record again. What’s more, the Recorder
doesn’t accept any input at run time and
lacks decision-making capabilities.

The good news is that your Recorder
macros can span a number of Windows
applications simultaneously, so you can
copy data from one to another. And, a
macro recorded in one application can work
in another, provided its moves make sense.
So, if you find you’re constantly involved in
repetitive tasks, the Recorder can be a
time-saving tool, and despite the
restrictions we’ve already mentioned, the
uses to which it can be put are legion.

Recorder saves its macros in files with
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an REC extension.
You can keep many
macros in a single

useful to do this. For

instance, you can @ J" @

Cardfile Calendar Caleulator Clock Character Map

have a group of
macros called
“printers”, each one
installing a specific
printer as the default
Windows version. You

A

REC file, and it is often Wiike Faintbrush Terminal Recorder Sound

Media Player Media Browser Object

Accessories A | o

g 2 A

Recorder

Packager

could have another file

of macros called

“letters”, where you keep personal details
and standard phrases you use in
correspondence such as “Yours sincerely”.
These can then be used in any Windows
text application: WordPerfect, Write,
Notepad. You're not restricted to the
macros you may have written in your most-
used word processor.

There’s no need to present a full-blown
tutorial on the Recorder here because the
manual is good enough. Instead, we've
provided some handy tips and examples.

The automated letter-writing macro

If you write letters, which are made up of
standard phrases, to different people you
can automate the process by having the
Windows Recorder type in the appropriate
one for you. Just select the ones you want:
1. Double-click on the camcorder icon and
from the Macro menu select Record.

2. In the Record Macro dialog box, type in a
name for your macro (Address, say) and a
shortcut key, perhaps A. (The Ctrl check box
will be crossed, so your shortcut key is in
fact CTRL A — see the Tips panel for the
reason why you should stick to CTRL.)

3. At the list box named Record Mouse,

select Ignore Mouse.

4. At the Playback To list box, select Any
Application.

5. If you wish, type in a description and click
on the Start button. The Recorder window
will minimise and start flashing.

6. Type in your Address with carriage
returns (CRs):

The Man with No Name <CR>

Clint Eastwood Estate <CR>

A Town called Hell <CR>

Wild West<CR>

7. Click on the minimised Recorder icon
and on the OK button to save the macro.
8. Select Record again and repeat the
above procedure for any other standard
phrases you use.

9. Finally, choose Save As and save all the
macros in a single file (PHRASES, say).

To use these, run Recorder and load
PHRASES.REC. From your word or text
processor, type the shortcut key for the
phrase you require, or double-click on the
name of the appropriate macro.

A Screensaver On macro
There are also cases where you would want
a single macro to be assigned to an icon so

Windows 3.1

that it will execute when you double-click on
it: setting the screensavers on and off, say.

If your machine is used by different
people with their own preferences about
how Windows looks, you can expand this
macro to change sets of Control Panel
settings (wallpaper, screensavers, colours
and so on), create a macro for each user
and store them all in the same file, which
can be run from the Startup group. All you
do is select which user is on.

1. Double-click the camcorder icon and
from the Macro menu select Record.

2. The Record Macro dialog box appears.
Type in a name for your macro, say Screen
Saver On, and a shortcut key, say 1. (You'll
notice that the Ctrl check box is crossed, so
your shortcut key is CTRL 1) .

3. At the Record Mouse list box, select
Ignore Mouse. Type in a description, and
click the Start button. The Recorder window
will again minimise and start flashing.

4. Press: ALT F, then R. Type in
CONTROL.EXE and press <CR>. Now
press: ALT S/ D <the Tab key — 3 times>,
<Down/Up arrow to the select the
screensaver scheme you want>, <the Tab
key> 1 <CR> ALT + spacebar C.

5. Click on the minimised Recorder icon
and the OK button to save the macro.
Select Record again and repeat the above
procedure for Screensaver Off — you select
None as the screensaver scheme.

6. Choose Save As and save all the macros
in a single file (SCREEN, say).

To make these macros run
automatically, see the procedure outlined in
the main text (@bove) and replace
MYMACRO.REC with SCREEN.REC, and
the shortcut key with CTRL 1, or anything
else you want to use. To give a macro an
icon so that it can be run with a double
mouse-click, select New from the File menu
of the Program Manager, click on Program
[tem and at the text box reading Command
line, insert:

RECORDER.EXE MYMACRO.REC

where MYMACRO.REC is the file containing
your macro(s). This will load the macro file,
but won’t play it. To play it automatically,
your command line should read:
RECORDER.EXE -h ShortCutKey
MYMACRO.REC

Here, to start the macro, you have to use
the shortcut key pre-defined in your file, and
the following conventions must be followed:
ALT is represented by % / CTRL by A/
SHIFT by +. So the command line for a
macro starting with the shortcut key-

Tips for macro recording

m There’s no need to assign a name and a
shortcut key: either is adequate, but you
must define a shortcut key if you want to use
one.

m Although you’re allowed to use ALT as part
of your shortcut key combination, don’t.
You’re almost bound to run into conflict
problems because Windows and Windows
applications use it.

m |f you're preparing a macro to demonstrate
a piece of software or some method,
remember to select Recorded Speed as the
playback speed instead of the default Fast
option. Note that there’s also a Continuous
Loop option available which is useful for
continuously running presentations.

m Practice the moves first, and write them
down before recording.

m As far as possible, stick to keystroke
combinations only instead of mouse
movements and clicks: they present
problems because the screen positions are
also recorded, and opting for mouse co-
ordinates relative to the screen rather than
the window doesn’t necessarily help. The
only time you will need to use the mouse is if
you’re copying data or drawing graphics.

m Macros are transferable from one
computer to another but you’ll run into
trouble if the two machines use different
graphics resolutions or keyboard drivers.

combination CTRL F2, and stored in file
MYMACRO.REC will be:
RECORDER.EXE -h "“F2 MYMACRO.REC

Note that the above line implies that
MYMACRO.REC is stored in your Windows
directory; if not, you have to specify the
path. Therefore, if MYMACRO.REC is
stored in a directory called MACROS on
drive G, the above line would read:
RECORDER.EXE -h "“F2 C:\MACROS
\MYMACRO . REC

The default icon for macros is the
camcorder, but you can change that. There
are lots of macros you can design to do
many things. Windows Write, for instance,
can be enhanced with a macro to be used
for automating formatting. You can create
macros which combine a set of formatting
features like font size, style or indents to
create a selection of styles for headings and
paragraphs, so that a single mouse-click
does the job of five or six dialog boxes.
m We’'d be glad to hear from you if you've
thought of a really useful macro.
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If you have any queries or Win 3.1-related topics
to discuss, contact Panicos Georghiades and
Gabriel Jacobs at win3@pcw.co.uk.
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Windows 3.1

Lost ond font

Help! I've lost my fonts. Deleting fonts is a dangerous business — Panicos Georghiades and
Gabriel Jacobs tell you what you need to restore the status quo. Plus, a tip on Cardfile conversion.

aving been carried away with
your article about fonts in PCW
July, | removed all the fonts
except those | use. Big mistake! |
overlooked those that Windows holds for
Microsoft Works and Access, as well as for
its own use. Can you tell me what basic
fonts should be left in Windows\System?”
lan Shutes
ianshutes@enterprise.net
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We list here the fonts supplied with
Windows 3.1. They’re used for supporting
the system and Windows applications, for
DOS applications running in Windows and
data copied to the Clipboard from these
applications. As for Access and Works,
specific templates may use specific
TrueType fonts supplied with these
packages as extras. The system font files
for various screen resolutions are:
8514SYS.FON
EGASYS.FON
VGASYS. FON

OEM (Original Equipment Manufacturer)
font files, for various screen resolutions,
used for OEM text in the Clipboard Viewer
and as a character set for certain Windows
applications, are:
85140EM. FON
EGAOEM. FON
EGAOEM. FON
VGAOEM. FON

In addition, some variants of raster
screen fonts come with Windows, used for
printing text and graphics as bitmaps or
raster lines. The variants, each for a different
screen resolution, have one of the letters A
to F appended to the filename of the font.
Included with Windows 3.1 are B (EGA
display), E (VGA display) and F (8514
display). The fonts are:
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COURX . FON
SSERIFx.FON
SERIFx.FON
SMALLX . FON
where the X is a letter A to E. For instance,
SSERIFE.FON is the VGA variant of
Microsoft Sans Serif. Windows also comes
with three vector (fully scalable) font files:
ROMAN . FON
SCRIPT.FON
MODERN . FON

Most important of all, five TrueType fonts
are supplied with Windows (three of them
as families). Each font has (not shown here)
a file with a .FOT extension and a file with a
.TTF extension. Each filename for Arial,
Courier and Times New Roman, apart from
the regular font, is followed by BD for the
Bold version, | for the Italic version, and Bl
for the Bold ltalic version. For example, the
regular Arial filenames are ARIAL.FOT and
ARIAL TTF. Arial Bold ltalic requires
ARIALBI.FOT and ARIALBI.TTF.

The supplied TrueType font files are
ARIAL (Arial), COUR (Courier), TIMES
(Times New Roman), SYMBOL (Symbol)

Fig 1 Be careful not to delete fonts required by
system and Windows applications

and WINGDING (Wingding). Also to be
added are certain fonts used for displaying
non-Windows applications in a window:
APP850.FON DOSAPP . FON
CGA40850.FON CGA40WOA. FON
CGA80850. FON CGABOWOA. FON
EGA40850.FON EGA40WOA. FON
EGA80850.FON EGA8OWOA. FON
HERC850.FON HERCWOA . FON

VGA850.FON VGA860.FON
VGA861.FON VGA863.FON
VGA865.FON

Since you have deleted many of the
supplied fonts and we don’t know anything
about your requirements, it would probably
be best to re-install all the standard
Windows fonts we’ve mentioned.

MPEG empathy
“How can | tell if | have MPEG capability?
I’m sure | do, but | don’t think | have the
software and/or drivers to view the files.”
Andy Davis
alchemist@emarkt.com

MPEG playback capability, which enables
you to view full-screen full-motion video files
including Video CDs (commercial movies
and pop videos) comes in three flavours:

1. Software-only utilities.

2. A chip on an S-VGA graphics card.

3. A separate MPEG card, sometimes
attached to the graphics card with a cable,
or as a daughterboard.

If you do have the drivers installed you’ll
see the relevant lines in the Drivers section
of the Control Panel. MPEG is installed as
an MCI (Media Control Interface) device, like
sound cards and CD-audio, MIDI, animation

Windows 3.1

Cardfile conversion

easily without them:

Printers icon in the Control Panel.

button, and select No Page Break.
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One use of the Print to File facility is to convert certain non-ASCI| file formats to ASCII for
importing into other applications; an example being Windows Cardfile files. A number of utilities
are available in the public domain for converting Cardfile files to ASCII, but the job can be done

1. Install the Generic/Text Only printer driver and configure it to Print to File. Do this from the

2. Start Cardfile and load the file you want to convert. Select Print Setup from the File menu, and
in the dialog box select Specific Printer, then the Generic/Text Only driver. Click on the Options

3. Go to the File menu, select Page Setup and clear the Header and Footer boxes. Close dialog
boxes and select Print All from the File menu. Enter the path and filename with, say, a .TXT extension.
4. You can now load this text file into a word processor, although you may find that you have to
do some cleaning up, such as getting rid of blank lines.
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Fig 2 Checking for MPEG drivers

and other multimedia elements (Fig 2).

If the drivers aren’t installed, have a look
on your hard disk for any directories
containing drivers and documentation
about the card. The software may be on the
hard disk, even though it’s not installed.
Failing that, open your PC and have a look
at the hardware. Check your graphics card
and any card next to it: every adapter card
has a label printed on its PCB. Also, have a
look at the names of the chips on the cards:
many MPEG cards use a C-Cube chip.
There are only about ten makes of MPEG
card sold in the UK, so you should be able
to identify whether you have one or not.

Changing names

“In May’s PCW, in the Hands On section,

Tim Nott wrote about how to change the

username and company name of a PC.

What is the Win 3.7 version of this solution?”
globalte@users.AfricaOnline.Co.Ke

in SERIALNO.INI (Windows directory) in
Workgroups 3.11. The latter is an editable
file, so if you have Windows for
Workgroups 3.11, use Notepad or some
other text editor to put in the name(s) you
want, and re-start Windows. Simple!
Not so simple with the other versions
mentioned above, though. But there is an
undocumented and unsupported method
(with a warning from Microsoft that it
doesn’t encourage its use). So if you're
using Windows 3.1, 3.11, or Windows for
Workgroups 3.1, here’s the answer, but on
your own head be it if you decide to use it.
1. Choose Run in the File menu of the
Program Manager and enter SETUP /F as
the command line, then OK.
2. Enter the new name and company name
and click Continue. Then confirm.
3. The Setup Options screen will be
displayed: again click Continue. Same with
the Install Components screen, and if the
Swap File screen appears, do the same.
4. You'll be asked to insert a Windows disk
in drive A:. Click on the Exit Setup button
and confirm the exit. Exit Windows, and
when you re-start, the new name and
company name should be displayed. We
have tried this on some machines with no
problem, but we take no responsibility.

When Windows is first installed, you’re
asked for your name and company. This
data is stored in the file USER.EXE
(Windows/System directory) in Win 3.1,
3.11 and Windows for Workgroups 3.1, but

POW conest

If you have any queries or Win 3.1-related topics
to discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.co.uk.
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Windows 3.1

Hands off my PC!

Are pesky people doing things to your desktop? Panicos Georghiades and Gabriel Jacobs
unlock the secrets of security using progman.ini, and release a secure screensaver tip, too.

his month, among the letters we
have received, we return to the
perennial cry of “Who's been
messing with my machine?”

Keeping it in the family
Q. “I need some help — someone in my
family keeps mucking up my desktop. At the
moment | have got my computer asking for
the first letter of my first name, then copying
the *.GRP files and the *.INI files from the
users\glenn directory to the Windows
directory. Is there an easy way to stop
people doing this?”
Glenn Moseley

moseleyg@usa.net
A. Someone in your family has created
directories which hold Windows
configurations for individual users and which
are initiated before you start Windows.
Provided these are updated when you exit
Windows and that your machine doesn’t
suffer from crashes, there’s no harm done.
And, of course, this does solve the problem
of different users using the same machine
and having different preferences settings.

If you don’t want others to use your
machine, use your hardware key, if you
have one, to lock it up. We suggest a
password method in the screensavers
section later on in this column, but if your
mystery family member is clever enough to
have thought of the method you’ve
described above, only a physical lock may
stop the perpetrator.

Getting the boot

Q. “Having recently decided to use a
multiple boot configuration | noticed, in your
March column, an item about installing
Windows 3.1 and Windows 95 on the same
machine and it would automatically start
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into Windows 95. | run most programs
through Windows 3.1, is there any way to
boot into DOS/Windows 3.1?”
lan McDougall-Ryan

balls@mail.zynet.co.uk
A. You need to edit the hidden and read-
only system file MSDOS.SYS, found in the
root directory of your boot drive, and add
the line
BootWin=0
in the [Options] section. After you’ve done
that, your machine will boot into MSDOS by
default instead of into Windows 95.
Pressing F4 just before the “Starting
MS-DOS” message at bootup will start
Windows 95. Please use a text editor (such
as Notepad) to edit MSDOS.SYS. Be very
careful and remember to revert its attributes
back to hidden and read-only after you've
edited it. In addition, do not delete all those
unnecessary-looking lines full of “x”s at the
end of the file: they are needed.

Wild filed

Q."In your Windows 3.1 column in the June
issue of PCW, you mentioned cutting and
pasting the filename in File Manager’s
Rename dialog box. As | am sure you know,
you can also use wildcards. In the To: box
you can enter *.bak, for instance, to change
Jjust the extension of the file in the From:
box. In fact, you can rename multiple files in
this way, and you do not need to select
them first.

For example, in the From: box, type in
\chk*.* and in the To: box enter \abc*.*
(should you, for some reason, want to
change the first three characters of
Checkdisk’s multiple files in the root
directory!).”

Steve Rainey
UnisoftComputers@compuserve.com

House-train a screensaver

Screensavers, originally designed to save
our monitors from burning out, are
nowadays used just as much for adding
user individuality to machines as for
preventing others from accessing machines
when you are not around. But a
screensaver, however cute and harmless it
may appear, is yet another program running
in the background along with your main
applications, doing its bit to slow your
machine down or popping up at times
when you wished you’d never installed it in
the first place.

The solution is to invoke it only when you
choose - if, say, you are planning to be
away from your desk for a considerable
length of time. You can do this by assigning
Program Manager icons and/or shortcut
keys to the screensavers of your choice:

1. Using Notepad (or any other text editor),
change the line in the win.ini file that reads
Programs com exe bat pif

to

Programs com exe bat pif scr

Then exit and restart Windows, so that this
can take effect. To add a screensaver icon
to an Application Group: from the Program
Manager’s File menu, select New, then click
on the New Program ltem radio button,
then on OK. Type a description into the
Description box and the command line in
the Command Line box.

Valid command lines for the
screensavers in Windows 3.1 are:

« SCRSAVE.SCR for a Blank Screen

o SSFLYWIN.SCR for Flying Windows

« SSMARQUE.SCR for the Marquee

o SSMYST.SCR for Mystify

« SSSTARS.SCR for the Starfield
Simulation

...or any other .SCR files you may have.

You can also assign a shortcut key in the
Shortcut Key text box, by pressing the key
of your choice.

Before enabling the screensaver, it's a
good idea to configure its options. To do
this, press the shortcut key or double-click
the screensaver’s icon and make changes
to the dialog box which appears. Here, you
can also add a password.

Up to this point you won’t be able to
start the screensaver. To be able to start it
by selecting the shortcut key or clicking on
its icon you need to add the /S switch to its
command line. To do this, select the
screensaver icon, then choose Properties
from the File menu. On the command line,
add the /S switch. For example, enter the
following in the Command Line text box:
SSTARS.SCR /S

The screensaver program icon will now
behave as any other program icon. It will
start the screensaver when you double-click
on it — handy if the boss walks in when
you’re playing Solitaire.

This will also provide an extra level of
security when starting Windows. By giving
the screensaver a password, then copying
the screensaver into the Startup Group, it
will start every time Windows starts, and
no-one else will be able to use your
Windows installation just by typing Win,
unless they know the password (see
adjacent panel).

Security using progman.ini

Being 100 percent sure that the subject of
machine security will crop up repeatedly,
we offer here a few more restrictions you
can apply, this time by using the
progman.ini file. Progman.ini is Program
Manager’s initialisation file. In essence, its
purpose is to contain information which tells
Windows what should appear in the
Program Manager window and how these
things should behave.

Generally speaking, settings in
progman.ini are automatically updated by
Windows when you create groups and
make certain changes. But it’s possible to
make changes to progman.ini using a text
editor like Notepad. For instance, you may
wish to add a [restrictions] section to the
usual [settings] and [groups] sections.

The [restrictions] section consists of
NoRun=
NoClose=
NoSaveSettings=
NoFileMenu=
EditLevel=

Windows 3.1

Set a secure screensaver

[ ]r
Description:
Command Line:
Working Directory:
Shortcut Key:

Program Item Properties
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1. Having added the
.SCR extension to
the Programs= line
in the Win.INI and
re-started Windows,
add your
screensaver as a
New Program item in
Program Manager

2. Double-click on the
screensaver icon and
change its options

3. Add a password

4. Click on the
screensaver icon and
add the /s to the
command line in its
Program Manager File
properties
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5. Move the screensaver to your

StartUp group

6. When you start Windows, you
will now have to enter your
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Windows 3.1

HELP help

2. Click on Edit, then select Annotate.

the screen.

5. Click on Delete to remove the comment.

File Edit

To add your own comments to Help screens:
1. Go into Help and to the area in which you would like to add comments.

Bookmark Help

3. Enter your text, and click on Save. You will notice that a paper-clip icon now appears on

4. When you click on this paper-clip, a pop-up window displays your text.

Notepad Helpr

Euntentsl Search I Back I History E

Contents for Notepad Help

inclows Motepad 5 a text editor that v
ALUTOEXEC BAT file.

Tolearn how to use Help, press F1

® NoRun=1 will disable (dim out) the Run
command on the File menu so a user won'’t
be able to run applications from Program
Manager unless the applications are set up
as icons in a group. This prevents
unauthorised use of certain applications.

= NoClose=1 disables the Exit Windows
command on the File menu, so the user will
be unable to leave the Program Manager
via either the File menu or the Control menu
(the Exit Windows and Close commands
will be dimmed), or by using Alt + F4.

m NoSaveSettings=1 prevents the current
settings being saved on leaving Windows,
by disabling the Save Settings on the Exit
command in the Options menu. It overrides
the SaveSettings= entry in the [settings]
section of progman.ini: useful when you've
defined the settings you need and don’t

want anyone to mess them up permanently.

m NoFileMenu=1 removes the File menu
from Program Manager (disabling New and
Delete operations, in particular). But a user
can still run applications with icons in
groups. And unless you've disabled the Exit
Windows command, a user can still leave
Windows via the Control menu or Alt + F4.
m EditLevel= followed by a number
between 0 and 4 sets certain restrictions
affecting the level of privilege applicable to
making changes to the Program Manager.
m 0 allows a user to make any change

(the default).

m 1 prevents anyone from creating, deleting
or renaming groups. The New, Move, Copy
and Delete commands on the File menu are
unavailable when a group is selected and
this can therefore be used in conjunction
with the NoFileMenu=1 entry.
m 2 sets all restrictions in level 1 and
prevents the creation or deletion of program
items. The File menu’s New, Move, Copy
and Delete commands are unavailable.
m 3 sets all restrictions in level 2 and
prevents anyone from changing command
lines for program items. The text in the
Command Line box in the Properties dialog
box cannot be changed.
m 4 sets all the above restrictions and
prevents people from changing any
program item information. None of the
areas in the Properties dialog box (which
will all be dimmed) can be changed.
m To change your restriction settings,
simply remove the entry concerned or set
the value to O.

But what’s to stop a user getting into
progman.ini and altering the settings to
remove restrictions? That’s another story!

POW coneet

If you have any queries or Win 3.1-related topics
to discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.co.uk.




Windows 3.1

What a performance

Panicos Georghiades and Gabriel Jacobs investigate SmartDrive, which is installed on your
machine but uses some of your RAM. Learn how to alter settings to improve performance.

here are many things you can do
to your machine to increase its
performance: get more RAM, get

a larger and faster hard disk, get a faster
graphics card, and so on. Of course, they
all cost money. The cheapest and most
effective option is to upgrade the RAM
(12Mb is now our recommended minimum).
But there are other things you can do
which don’t involve buying anything, like
taking a good look at how your machine runs
and making a few changes to optimise its
performance. Your machine is a team rather
than a single worker, and the team needs to

be co-ordinated. Think of it as handling the
queues at a supermarket, with ordinary
checkouts, wide checkouts, checkouts for
eight items or fewer, and so on.

While the performance of MSDOS
programs relies mostly on how much free
memory is available below 640Kb,
Windows 3.x performance relies on the first
few free megabytes of available extended
memory, above what is required for
Windows itself (a good average estimate to
work with is about 3Mb).

Once Windows runs out of extended
memory it starts using the hard disk to store

= About Program Manager

Microsoft Windows Program Manager

Yersion 3.1

i Copynght © 1985-1992 Microsoft Corp.

386 Enhanced Mode

Memorny:

Syztem RBesources:

Yergion 3.1

WIHDOWS.

I Copyright @ 1385-1992 Microsoft Corp.

27.956 KB Free
81% Free

= About Program Manager

Microzoft Windows Program Manager

By checking memory
beforehand and while
an application is

386 Enhanced Mode
Memory:
System Resources:

26.232 KB Free
55% Free

running you can
estimate how much
memory it uses
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temporary files, and hard disk performance
can be between ten and thirty times slower
than that of RAM. A PC fitted with 8Mb of
RAM can be as slow as a tortoise, while the
same PC with 12Mb of RAM can run as
smoothly as if it had 32Mb. It all depends on
whether the additional 4Mb has made the
difference between swapping to hard disk
or working in RAM alone.

Smart move

When your machine reads and writes data to
the hard disk, it uses a program called
SmartDrive (smartdrv.exe) to hold information
in memory (in a so-called disk cache) so
larger chunks of data are being manipulated
at a time and fewer mechanical trips have to
be made by the hard disk heads to the
drive’s magnetic material. If you can carry
more things with you, you make fewer trips
and your work is done more quickly.

SmartDrive is installed by default on your
machine. It uses some of your RAM and
you can alter the default settings to make
things run more smoothly. On an 8Mb
machine SmartDrive takes up 2Mb. The first
megabyte of your RAM isn’t available to
your Windows programs either, since
640Kb is taken by MSDOS and some other
bits and bobs like expansion boards (video
cards, sound cards). Add in the 3Mb
Windows itself needs and you're left with
only 2Mb for your programs.

Many programs require more than 2Mb
of RAM, and in these cases decreasing the
amount of RAM used by SmartDrive from
2Mb to 1Mb can decrease, or even
eliminate, disk swapping.

It’s up to you to investigate how much
RAM your individual programs use. Using
Program Manager’s Help and About menu
option, check the amount of RAM you have

MA
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available before you start a program, then
after you've started it and loaded a file, and
subtract one value from the other to get the
memory used by a particular program. Your
aim is to fit that amount of memory within
the RAM of your machine.

It may be evident at this stage that your
programs need a lot of RAM (say, more than
2Mb or 3Mb) and that you do need to
upgrade your RAM by buying more chips.
To find the physical memory available in
your machine and how it’s allocated, type:
mem/c
from the DOS prompt, when you’re not
running Windows, not from the DOS
prompt within Windows. And if you type:

Windows 3.1
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mem/c >pcw.txt
the information will be stored in a file called
pcw.txt so that you can do your calculations
while reading this from Notepad instead of
having the information flash up on-screen.

You'll now see how much RAM is free
after loading MSDOS and SmartDrive.
Subtract from this the 3Mb Windows will
take up and you’ll be left with the amount
your programs can use. If they can fit within
that amount, there won’t be much hard-
disk swapping — you'll be able to see and
hear whether this is going on anyway.

To change the values used by
SmartDrive, while still at the DOS prompt go
to the DOS directory (cd \dos) and type

Help. Follow the
= Calculator * | instructions and

Typing mem/c gives
you a rundown of how
your memory is used
under MDDOS

those of InitCacheSize
and WinCacheSize.

InitCacheSize sets
the size (in kilobytes) of
the cache when

499 SmartDrive starts

(before Windows is
loaded). The larger the
cache, the less often
data needs to be read

from the disk. If you don’t specify a value,

SmartDrive will set one according to the

amount of memory your machine has.

WinCacheSize specifies (in kilobytes)
how much the cache size will be reduced to
allow for Windows itself (when you exit
Windows, it returns to its initial size). The
default value depends on how much
available memory there is, but if you specify
a value smaller than that allocated to
WinCacheSize, InitCacheSize will be set to
the same size as WinCacheSize.

If you’re not running any DOS programs
which require extended memory, both
these values can be equal. We recommend
a larger SmartDrive value if you think your
hard disk is slow, and vice-versa. However,
these values must be relative to the total
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Windows 3.1

DLL dramas

Q. "I would appreciate your guidance on why DLLs seem to cause problems in Windows.

I recently had to reinstall Word on a laptop. All seemed fine until | ran the application. At 9.30pm the
only help I could think of was the Microsoft support desk in Canada! They very quickly identified the
problem and helped me to edit a couple of DLL files before reinstalling Word again. This seemed to

Chris Kushner 100634.75@compuserve.com

called at the time.

solve the problem but | didn’t get round to asking for an explanation. Can you assist?”

A. DLLs (Dynamic Link Libraries) themselves generally don’t cause problems, but they appear
to because when errors are reported on the screen they refer to the DLL which was being

DLLs are executable files that allow Windows applications to share resources. So, as their
name suggests, they can for example link applications so that when one is updated, the other
application takes account of the update. They’re often to be found in the Windows or
Windows\System directories, but can also reside elsewhere. They usually have a .DLL
extension, but some have .EXE and other extensions.

If an application is missing one of its DLL files, an appropriate and quite commonly seen
error message will appear: “Can’t find ....” (make sure that the DLL file is in the correct
directory). If an application is started with an outdated DLL file, the error message “Call to
undefined dynalink” will be displayed, and that may well be the error message you got. We
presume that the Canadians told you how to update the files.

was not found.

= Microsoft Word

“ord cannot open the YWord help file because WORDHELP.DLL

But there are no hard and fast rules. Play
within those two limits and see if you can
improve the performance by cutting down
on disk swapping. Note that Windows for
Workgroups 32-bit File Access replaces
the functionality offered by SmartDrive.
Cacheing is automatically disabled for
drives using 32-bit File Access and its
memory use is reduced to 128Kb. You
still need to use it, however, for cacheing
CD-ROM drives.

[t’s important you use the latest version
of SmartDrive available to you, as there can
be enhancements you require. You can
check which version you have by typing:
smartdrv /s

Version 2.1 shipped with MSDOS 4.01,
version 3.0 with Windows 3.0 and Windows
3.0a. Version 3.13 shipped with MSDOS
versions 5.0 and 5.0a, and Version 4.0
shipped with Windows 3.1 and 3.11.

Version 4.1 came with MSDOS 6.0 and
included support for DoubleSpace. Version
4.2 was available through online services
only and included a switch to clear the
cache. The latest versions are 5.0 which
shipped with MSDOS 6.20 and 6.21 and
Windows for Workgroups 3.11 (the first
version to support cacheing for CD-ROM

drives) and 5.01 which shipped with
MSDOS 6.22, fixed problems with Kodak
Photo CDs and included support for
DriveSpace disks.

It all adds up to a new Calculator
On this month’s CD-ROM and floppy disk
we distribute a new version of the Windows
Calculator, released by Microsoft, which
fixes a bug that occurs during subtraction of
decimal numbers and also makes the
calculator behave more like a handheld one.
The bugged version comes with Windows
3.1 and 3.11. Try 25.22 minus 25.21. You'll
get 0.00, 0.0099999999, 0.010000001 or
0.0000, rather than the correct answer of
0.01. Try also (1/3 + 10 - 10) x 3. You'll get
1.0 not 0.9999 which is what you would get
on a handheld calculator. This is due to the
fact that significant digits are lost by adding
and subtracting 10.

See this month’s disc for instructions on
how to install the new Windows Calculator.

If you have any queries or Win 3.1-related topics
to discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.co.uk.
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Font memories

It’s not goodbye but au revoir to too many TrueType files — they can slow things down.
Panicos Georghiades and Gabriel Jacobs show you how to group fonts for specific jobs.

indows, and most of its
W applications, copy and store
TrueType font files to the

Windows\System subdirectory. But having
lots of fonts installed (more than 100, say)
can slow things down. So, it is a good idea
to keep groups of fonts dedicated to
different jobs in separate directories, and to
edit the [Fonts] section of your win.ini file to
keep only those fonts you need for a
particular job, by adding or subtracting
groups of entries.

Suppose you want to manage three
groups of fonts: one for everyday use, the
other two for projects
on which you work
only occasionally.

Bzalalled fonda:

Fewaclis BT [Touel i_ #*
Az arilinc Dy | Vs [ ppa |

Fiphwasr Foimal [Tiwe T pges]

Agmall [T rueT ppel

Bl Bl:lillliw'l'lﬂ:-ell

Bl Bl Madue | Vs Tpp) *

Remove fonts but do not
delete them from the disk

Sampic
COBBCCXXYYZZ 15

=
Tha i & scslahls T pp= lonl thal can be dirplaped
oy by wOieeen sieid pimiead of pos poniei

Wiy gizes af thie Dok o the disk e 152 KB

Using an editor such as
Notepad (run two
instances) you can cut out
and save to two separate
files (say, project1.txt and
project2.txt) the group of
entries referring to the fonts

in the two different

directories. This il leave

your win.ini with only the

Keep the everyday Are you sure you want to remove the AmericanUncD fonts for normal use. Each
, [TrueType] font? )

ones in the time you want to use the

Windows\System [] Delete Font File From Disk special fonts, all you need

subdirectory, create

do is edit win.ini and paste

two other directories

| [vestoan]| | mo

I | Cancel I

in the lines you have

(for instance, Project1
and Project2) and
install the fonts as necessary.

To move the currently installed TrueType
fonts to a directory other than the default
Windows\System subdirectory, open the
Fonts icon in the Control Panel. Select all
the TrueType fonts you want to move and
then choose the Remove button.

The Remove Font window will ask for
confirmation about deleting each TrueType
font. Make sure that the Delete Font File
From Disk check box is not checked, and
then choose the Yes button — in other
words, remove the fonts from the
installation, but not from the hard disk
(Figs 1 &2).

Next, from File Manager move all the
TTF files, of those fonts you want moved,
to the two directories (Project1 and
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Project?). Restart Windows, and from the
Fonts icon in Control Panel choose the Add
button. Specify the c:\project1 directory
from the bottom of the Add Fonts dialogue
box. Windows will begin retrieving all the
font names from that directory (Fig 3).

Disable the Copy Fonts to Windows
Directory option by clearing the check box
at the bottom of the Add Fonts dialog box,
choose the Select All button, then OK. Do
the same for the Project2 directory fonts
and restart Windows.

The [Fonts] section in your win.ini will still
contain entries which will refer to .FOT font
files in the Windows\System subdirectory,
even though the .TTF files (the largest in
size) are now in the Project1 and Project2
directories.

previously cut out.

Question time

Q. “Is there definitive literature on Windows
for Workgroups 3.11 that explains the
meaning of all valid entries in the system.ini
and win.ini files, the relationship of these
files and their entries in the registry and the
software that may have caused the entries?
| ask this with a view to removing any which
are not required.

“In my win.ini file | have the title
[wt4gpi8sb6bz]. This precedes a selection
of font types which are repeated in the
section titled [fonts]. In my system.ini file
under [386ENH)] | have the following three
entries:

COM1AUTOASSIGN=
COM2AUTOASSIGN=
LPT1AUTOASSIGN=

[ e = r—
hegl Nparsded W Bold {1oml =l
Lhpsnby Nadad [T el

(At Eragas B ol [Tranlveal
Mﬂlmtﬂ:ﬂﬂ.—
[=rrimes

5 ‘gl Tisream

= ] [ e pace [&
4 T [Eeme T

=l O ¥ I i D
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Windows 3.1

= The COM1AutoAssign= and
COM2AuUtoAssign= lines indicate
how Windows will treat requests for

[l e 8 I ol oo [ o =
- Tmarll . .
ol e :! st | | 1o yse of your communications
L]

b | ports by more than one application if

one of them is a non-Windows
application.

A value of O means that any
application can use the port at any
time. A value of -1 means you will get

Fig 3 Re-install the fonts but do not copy them to the

Windows directory

“What are the valid parameters?”
CA Hewitt
cc@dartnet.co.uk

A. The [wt4gpi8s56bz] section in your
win.ini is the remainder of an aborted or
failed upgrade session.

During an upgrade session (say from
Windows 3.0 to 3.1 or 3.11) the first part of
the Windows Setup disables certain
Windows components: namely all fonts
except the system, fixed pitch, and OEM
fonts, the Shell (Program Manager, Norton
Desktop for Windows, and so on), the
desktop bitmap, screensavers, Task
Manager and installable drivers loaded
through the Drivers= line in the system.ini
file. These components are to be replaced
by the new version’s components so that
they don’t interfere with the upgrade
process.

If the Setup process is interrupted before
the Windows graphical user interface mode
portion has been completed, some or all of
the above items may not be properly re-
enabled. Fonts are disabled by renaming
the [Fonts] section in the win.ini file to
[wt4gpi8s56bz].

Setup can encounter problems with re-
enabling the old fonts if the system memory
is very low or if two aborted installations
have occurred. If there is a problem, Setup
will display a message box telling you that
trouble was encountered when restoring
the previously installed fonts and that the
[Fonts] and [wt4gpi8s56bz] sections must
be merged by hand. So to do this:

1. Open win.ini using Notepad.

2. Delete any line from the [wt4gpi8s56bz]
section that is duplicated in the [Fonts]
section.

3. Append the contents of the
[wt4gpi8sb6bz] section to the [Fonts]
section.

4. Delete the [wt4gpi8s56bz] section.

a message asking you which
application should be given control of
the port.

The value of a positive number up
to 1,000 represents the number of seconds
after an application stops using the port
before another application can use it (the

Calendar tricks

Many people use Windows Calendar as
a simple alternative to Lotus Organizer
and its ilk. Unfortunately, it is very
limited. For example, it will not allow
you to print the Month View grid.
However, it is possible do this by
pressing Alt +PtrScr to capture the grid
to the Clipboard, opening Paintbrush or
any similar program, pasting the
picture, and printing it (Figs 4 & 5). Or,
Calendar will print only appointment
times if there’s an entry. So, to print
blank entries, simply enter a space on
the relevant time line(s). By the way, put
Calendar first in the Startup group, and
you see immediately what you’ve got on
that day as you boot up.

— Calendar - WORK.CAL BB

File Edit Yiew Show Alarm Options Help

1:32 Monday, 07 April 1997

7:00
8:00
9:00 Meeting
10:00

11:00

12:00

13:00 Lunch
14:00
15:00
16:00

18:00
189:00

To:

17:00

Print Appointments:

| | Cancel

Figs 4 &5 § ke
To print the month view of the 3

paste into Paintbrush

Calendar, copy the screen and = ,‘- |
L
om
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Windows 3.1

Sound Recorder

Sound Recorder is a free Windows accessory for playing, editing and recording sound files,
although for recording you need a sound card and device drivers (to be installed in the Drivers
section of the Control Panel). It’s designed for small voice message files you would usually
attach to documents, as opposed to long pieces of music. For this reason, it has a maximum
default recording time of 60 seconds, but you can increase this time using this technique:
Record for the 60-second duration and Save As using any name, say “empty.wav”. Next,

choose Insert
File from the
Edit menu, and
select
empty.wav.
This increases
the recording
duration to 120
seconds. You
can repeat the
process as
many times as
you like, to
increase the
recording time,
until there’s
not enough

memory to

continue.

default is 2). To change a value, use the 386
Enhanced icon in the Control Panel.

The LPT1AutoAssign= entry is for your
printer port and applies only to Windows
3.0. As in your case, although it may still
appear in the system.ini after an upgrade, it
will have no effect.

Template time

“Regarding your ‘Step-by-Step Guide to
creating Write Templates’ [PCW, Aprill:
Although you are correct about using
templates — and also probably following
Microsoft’s ‘right way to do things’ — when
creating templates from Word or any other
application, you can get away with just
putting the path and filename of the
template. Provided the file type is registered
in File Manager, the relevant application will
automatically be launched.

“I know this saves very little time
compared with using a template but I had
never thought of doing it the way you
suggested. However, doing it in the way |
have mentioned above has never been any
trouble to me. Well, it takes different
strokes, doesn't it?”

Justin
justinc@j-catter.demon.co.uk

Yes, this will work fine for the example we
gave about using templates with Windows
Write (as well as with lots of other

programs). But be careful with templates
that involve file types which can be
associated with different programs; usually
images (BMP, PCX etc. and files like TXT
and DOC). New applications you install
have a tendency to associate files to
themselves.

Quick switch

“Having read your column about booting
Windows 95 and MSDOS off the same hard
drive [PCW, March], | thought | should
mention that there is an easier way to
switch back to DOS on booting.

“In your article, you mentioned pressing
F8, then going to option 8. Instead of
pressing F8, try pressing F4 and it will
perform these two steps in one.”

Chris Beaumont
cbeaumont@compuserve.com

Thanks, Chris. This undocumented option is
what was used in the beta release of
Windows 95 and it still works, provided you
don’t want to access any of the additional
Start options available with F8.

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.vnu.co.uk.
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All that glitters...

Even if you upgrade your RAM, you may still get “low memory” messages; it’s the first
megabyte which sets the gold standard. Panicos Georghiades and Gabriel Jacobs explain.

ur March column,

which dealt with

installing Windows

95 and Windows 3.x/DOS on

| [

the same machine, struck a

chord with many readers. We
have been fairly inundated
with queries about specifics,
S0 here is a selection.

Q. “Your article encouraged
me to try the Win95/3.x/DOS
combination. As my present

setup already has a multi-
config start-up menu, I'd like
to check whether or not this
may cause problems? | hope
it will be straightforward and
that | can continue to enjoy
multi-choice in DOS.”

James McFarlane

Al oy [0 el os]lim|
a2l A0 10 e 5

|

Paintbrush - [Untitled) =)
Paintbrush - [Untitled] v~ |
Paintbrush - [Untitled) hal =
Paintbrush - [Untitled) v ||
Paintbrush - [Untitled] b ol
Paintbrush - [Untitled] w4 |
Paintbrush - [Untitled) L4 =
Paintbrush - [Untitled) he

Text Options  Help

___[a] |

[ | [ I

j.mcfarlane@uea.ac.uk

A. There will be no problems Fig 1 The size of the opening window of some applications depends on available resources. As resources get

with your present DOS
multiple-boot configuration
menu. Since this is part of your DOS
config.sys and autoexec.bat setup, it will
come into effect only after you have
selected to start with DOS instead of
Windows 95.

Q. “Having installed Windows 3.11 and
Windows 95 onto the same hard drive in
directories Win3.1 and Win95, is it
necessary to load software into
C\win95\application or C\win371\
application, or do you just load them into
C\application?”
John Wright

john_wright@compuserve.com
A. As we said in the article, only a few
simple programs can be run from both 3.1

244 * Personal Computer World ¢ June 1997

and 95 installations: those that don’t, keep
settings in the Windows INI files, and don’t
have their own INI files in the Windows
directories. All the others must be installed
twice; once for 3.1 and again for 95.

We don’t recommend that you run
programs installed under Win3.1 in Win95
or vice-versa. The idea is to use 3.1 for
those programs that can’t be run under
Win95, either because they do something
specific or incompatible, or because they
use hardware peripherals for which you
don’t have 32-bit 95 drivers. Anyway, if a
program runs OK in Win95, why run it under
Windows 3.17?

To avoid problems, think of the two
installations as two sides of a coin which

less, so does the size of the window [see James Thompson’s letter, overleaf]

should never interfere with one another. The
straight answer in your case is that you
need to keep both application directories
separate.

Q. “I'm using Win3.1 but | also want to
use Win95, and having read your article,
| want to attempt the dual operating
system. However, I've managed to get
myself Win95 OEM, and was wondering
if it is still OK to load it together with
Win3.1. I understand that the OEM version
handles FAT32, and | am not sure if it will
still be safe.”
Panos Panayides

PAN4DEM@aol.com

A. You can't install both operating systems

using the method we described if you have
the OEM version that uses FAT32 (File
Allocation Table), otherwise known as the
OSR2 version. Microsoft technical support
says that you need a fix program which you
can get from them.

Q. “I'm a long-time PCW subscriber, still on
DQOS 6 and Windows 3.1. Could you please
tell me how to ensure that an application
always starts in a maximised window?
Some of the programs don’t seem to have
an INI file associated with them.”
James Thompson

A. Under normal circumstances, unless
your application has its own INI file or some
special setting that goes in the win.ini file,
you can't set it up to start maximised. This
is true of applications such as Write and
Paintbrush which open up windowed, and
the size of the windows depends on
resources — if you keep opening windows
one after the other, they will get smaller and
smaller (Fig 1). With applications that have
an INI file, the setting would be
Maximize=1

If you have Visual Basic or some other
Windows programming language, you can
write a little program which will start the
application you want and then maximise it,
using the SENDKEYS command which
sends keystrokes to the application you
have executed.

One megabyte is worth its weight in gold
You've just upgraded your memory to 16,
32, or even 64Mb of RAM and yet you are
still getting messages like “Application
Execution Error”, “Insufficient memory to
run this application”, “Quit one or more
Windows applications and then try again”,
or “Not enough memory available”.

You’re not alone. Low memory is the
root of many computing problems, and in
many circumstances this isn’t due to the
physical memory in your machine.
Unfortunately, when error messages refer to
“memory”, they’re not all alluding to the
same thing. Computer memory is divided
into many different chunks, each with its
own name and its own job to do. And the
most important of these chunks is the first
megabyte; the one in which DOS resides.

When Windows starts a new program (a
task), it creates a task database (a TDB) for
it. This contains vital information such as its
current directory, its instance handle, and
so on. To maintain compatibility with 16-bit
Intel processors and MSDOS, the TDB is

Windows 3.1

The Write stuff

When using Write:

m For a soft hyphen, press Shift + Ctrl + Hyphen (this is useful with the paragraph justify setting).
m To select all, (mark) the entire document, press Ctrl and click between the left margin and

the left edge of the screen. This is far easier than dragging the mouse through pages and

pages of text.

m To edit two documents simultaneously, simply run a second copy of Write while the first is still
running (you can copy and paste between the two, of course).

m To align decimals in tables, check the Decimal box in the Tabs window. To align tables of
money values, set tabs and check the Decimal boxes associated with them.

m To print multiple columns, print once for each column using different indents.

=] Write - WINI706.TXT [=]=
File Edit Find Character Paragraph Document Help

- To edit two docurnents simultaneously, sitnply run a second =
copy of Write while the first is still running (you can copy and
paste between the two, of course)

- To align decimals in tables, check the Decimal box in the Tabs
window. To align tables of money values, set tabs and check the
Decimal boxes associated with them.

- To print multiple colummns, print once for each column using
different indents.

Write - WINIZ705.TXT
File Edit Find Character Paragraph Document Help
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Use Paste or Paste Spedial, and what about all the options in the Paste
Spedal dislogue boxe

Well, Paste is paste - simple as that. But the choices you see in the Paste

Spedal dialogue box will depend on the format of the object in the
Page 1 « |

]

Above To edit two documents simultaneously, run Write, twice

Below To align numbers or currency, use the Tabs settings and check the decimals box
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- To align decimals in tables, check the Decimal box in the Tabs
window. To align tables of money values, set tabs and check the
Decimal boxes associated with them.
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New names for old — a fast rename tip

difficult filenames.

When you rename a file in File Manager, the cursor goes automatically to the To: line in the
Rename dialogue box, and you’re expected to type in the new name. Very often you want the
new name to be something like the old one. If so, you can avoid some re-typing by copying the
old name in the From: line to the To: line. This is especially useful with convoluted or otherwise

Unfortunately, you can’t simply copy the filename by dragging and dropping. But there is a
way around this. Highlight the old name (or part of it), press Ctrl + C, click on the To: line, and
press Ctrl + V. You can then edit the new name in the To: line until you have the name you want.

= Rename

Current Directory: C:AWIN31

From: ||AP5L.EHE

To: |

Cancel |

Iz e
2 =

Use Ctrl+C and Ctrl+V to copy the old name to the new name, then edit it.

created in memory below 1Mb — in fact, in
the 640Kb of conventional memory. This
section of memory on your machine is so
much in demand and so limited, that it
should be treated like gold.

TDBs are not the only block of memory
that may end up below 1Mb. Applications
such as Word for Windows, Microsoft Mail,
Schedule+ and multimedia packages are
examples of applications that put DLL files
into the first megabyte of memory when
loading or performing certain operations. As
Windows loads segments of code, it gives
each segment an attribute which
determines how it will be treated. Segments
are marked, by Windows, as fixed or
moveable. Fixed code is allocated bottom-
up and, as the name indicates, cannot be
relocated. But moveable code can be
moved or discarded to make room for other
segments. If a fixed segment is too big to fit
into the available space, Windows moves
some moveable segments, if necessary, out
of the first megabyte of memory.

If there’s still insufficient room,
discardable segments, which can be
brought in later as required, are discarded.
All this moving and discarding is controlled
by a program called KRNL386.EXE.

An “out of memory” error that you get
when you try to start an application may
happen because fixed segments (precisely
because they’re loaded from the bottom up)
have been loaded in the first megabyte.
They cannot be moved and end up using
space which Windows may require to load
the TDBs.

What'’s the practical answer to all this?

There are several, but in general the idea is
to free as much conventional memory as
possible. You can optimise conventional
memory (with DOS 6 or 6.2) using
MemMaker, and/or you can achieve
satisfactory results by changing the order in
which programs and drivers are loaded. It’s
difficult to give precise advice here and trial
and error is usually the order of the day:
altering the loading order may well affect
where the fixed code gets placed.

Creating a multiple-boot configuration
can also help minimise what loads into
conventional memory for particular
operations — it may free enough space for
Windows to load the TDBs.

Other techniques include:

m Disabling any applications that start
automatically when you start Windows
(check the win.ini file and the Startup
group).

® Running Windows Setup and changing to
standard Windows drivers (VGA, No
Mouse, No Network).

m Using the Program Manager
(PROGMAN.EXE) as your Windows shell.

Finally, for troubleshooting, remove any
third-party Windows drivers or virtual device
drivers (VxDs) by re-marking them using a
semi-colon (;) at the start of the line in the
system.ini file.

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.vnu.co.uk.
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Starters orders

How to get applications to open on startup, getting stuck in to Paste, and gaining the
upper hand when your computer hangs. With Panicos Georghiades and Gabriel Jacobs.

he usual way of automatically
starting programs when Windows

is loaded is by moving (dragging)
or copying (dragging while pressing down
the Citrl key) all the application icons you
require into the Startup group window. To
automatically start all the applications found
within a particular group, you can change
the name of the Startup group entry in the
progman.ini file. Using Notepad, edit this file
to contain the line
Startup=“group name”
where “group name” (quotation marks are
needed) is any acceptable group in
Windows. For example, to start the
applications in the group Project A (a group
you created, and added in all the programs
you require for a particular project you are
working on), you would add the following
line to the progman.ini file:
Startup="Project A”

Acceptable group names are what’s
listed in the Window menu in Program
Manager or at the title bar of the group you
want to start automatically. Adding the
above line in the Progman.ini disables the
Windows Startup group until the line is
removed or commented out with a semi-
colon (;) at the beginning of the line.

What'’s a bitmap and what’s a picture?
One of the great things in Windows is the
ability to copy and paste from one
application to another, especially graphics.
But this isn’t so great when you're slowed
down by all sorts of obscure options. For
instance, do you use Paste or Paste
Special, and what about all the options in
the Paste Special dialogue box?

Well, Paste is paste — simple as that.
But the choices you see in the Paste
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File Options Window Help
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[Settings]
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display.drv=vgakahtx.drv
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Autofrrange=1

Startup="Project A"

Search Help
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[Groups]
Group1=C:\WIN31\PROJA.GRP
Group2=C:3ZWIN31VACCESSOR .GRP
Group3=C:\WIH31\STARTUP .GRP
Group4d=C:\WIH31\ADAPTECS .GRP
Group5=C:\WIN31\UWIDEOFOR .GRP
Groups=C:\WIN31\5PEA.GRP
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To automatically start all the applications in the group Project A (a group you created, and

added in all the programs you require for a particular project you are working on), you would add

the following line to the progman.ini file:
Startup="Project A”
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= Paste Special

Source: FPaintbrush Picture

00187108

Data Type:

Paste I

Picture

avie Link I

Cancel

Special dialogue box will depend on the
format of the object in the Clipboard. This
can be a bitmap or a Windows metafile
(Microsoft calls this a Picture), and selecting
either of these means that the object is not
part of an OLE (Object Linking and
Embedding) library: it’s a so-called static
object with no links to anything else.

If you select Bitmap from the Paste
Special dialogue box, the object will be
painted more quickly but will take up more
disk space when the file is saved. The
reverse is true of a Picture.

A bitmap file (extension may be BMP,
PCX, TIF, GIF etc.) is a grid filled in with
coloured dots. Its file size depends on its
width and height in pixels and its colour
depth: black and white (1-bit), 256 (8-bit) or
16 million (24-bit) colours. Scaling (resizing)
of bitmaps creates distortions, jaggedness,
and other unwanted effects.

A metafile or picture (the extension is
usually WMF) often consists of a variety of
different data structures (usually scalable
vector graphics, but it can include bitmaps)
and takes up little space. Metafiles can be
scaled, and printed using the highest
resolution of the printer. However, if one of
the data structures includes a bitmap, then
scaling will produce the same kinds of
distortion of the bitmap element as you
would get with an ordinary bitmap.

Try copying a graphic from a paint
program to the Clipboard and pasting it into
another application. You won’t see much
difference whether you choose Bitmap or
Picture in the Paste Special dialogue box.
Now copy a graphic from an application
which normally uses the metafile format
(Excel, say). Do this first by choosing

Bitmap, then Picture, and see the difference.

When in trouble ...
When your computer hangs, or when you
get a message about something being

unrecoverable, giving the machine the three
fingers treatment (Ctrl + Alt + Del) isn’t
always the best choice. Various problems
can cause software to behave badly or
crash, and even make your machine go into
a deep sleep. Some of these problems may
be caused by incompatibilities between
programs, or between programs and
hardware, or between different pieces of
hardware.

Sometimes (although not often) you may
find an answer in the documentation. If not,
you may have to contact a support service.
But when you do, you'll have to tell them
exactly what has happened, and for them to
be able to diagnose the problem, it has to
be one that can be repeated. If it can’t be,
you may have to do a lot of detective work
to find out the cause. Most problems in
computing are solved by a process of
elimination, which means you often have to
make a fresh start. And if your system has
crashed, you will have to do this anyway.

There are three ways to restart a
machine: (a) pressing Ctrl + Alt + Del (the
three-finger method); (b) pressing the Reset
button; and (c) turning the machine off,
waiting for a while, then turning it back on.
Never turn the machine off, then
immediately on, as you risk wrecking your
hard disk.

Which method?

The three-finger method is known as a
warm reboot and in most cases skips the
power-on self test. What's more, it generally
doesn’t reset all the adaptor cards in the
adaptor slots. Using the Reset button (a
cold reboot) usually makes the machine go
through its self test, but doesn’t necessarily
cut power to the motherboard or (once
again) to the adaptor slots. Therefore, to be
sure that everything has been reset from
scratch, you should turn off the power
completely. After about 15 seconds, the

capacitors in the motherboard will have
discharged and the hard disk will have
stopped spinning.

If you use the three-finger method or the
Reset button and the problem isn’t cured,
but it is cured if you turm the machine off
and on, this implies a hardware problem,
usually with a graphics card, internal
modem, sound card or other controller.

One final, important point: If you're using
a write-behind cache, make sure that the
contents of the cache have been saved to
disk before turmning off the machine. You can
do this with smartdrv.exe 4.0 or later by
entering SMARTDRYV /C at the DOS prompt.

Disk dilemma

Christian J. van den Bosch writes: “/ had an
empty 0.5Gb partition on my hard disk, and
| decided to turn it into a compressed
volume so | could copy a CD-ROM into it. |
went into DOS, typed DRVSPACE, chose
the partition, and chose to have 2Mb of
uncompressed space on the drive (this
being the minimum offered), but there were
a number of anomalies. The process took
about half an hour and included at least
three defragment operations using
Scandisk. The result was a 0.5Gb
compressed drive occupying 340Mb of real
space and a claimed compression ratio of
2:1, leaving 160Mb free (not 2Mb as
requested).

“All attempts to enlarge the compressed
drive (reduce the uncompressed space)
were rebutted: apparently, the remaining
160Mb of uncompressed space contained
files that could not be compressed. In the
end | just created a larger partition.

“Can you explain?”

<cjp@homenet.ie>

It’s normal for the process to take a long
time, even half an hour, and normal for the
Scandisk operations to check the disk.
DOS DrvSpace (originally known as
DoubleSpace) does not precisely double
the space on your hard disk. Doubling is an
estimation derived from an average
compression ratio. Different files compress
at different ratios depending on what they
contain. We carried out some experiments
on this, with the results shown (see the next
column).

We can’t explain why you got an
estimate of 2Gb with a compression ratio
of 2:1, except that sometimes the possible
compression is overestimated. In any case,
changing a drive’s estimated compression
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Utility of the month: SYSEDIT.EXE

Command Line:

If you like playing about with system files — editing your autoexec.bat, config.sys,
win.ini, or the system.ini files — there’s a Windows utility called SysEdit which has
been designed especially for this purpose. SysEdit.exe can be found in the
Windows\System directory (it can’t be run from DOS) and it opens all four files at the same time.
It also creates a backup of the original file with an SYD extension. When booting a system from a
floppy drive, note that SysEdit brings up the autoexec.bat and config.sys files found in the root
directory of your boot hard drive, not the ones on your floppy.

|E:W|I’IH31 WSYSTEMASYSEDIT.ERE Cancel

[ ] Run Minimized

You can run File Edit Search Window

Browse. __

System Configuration Editor -3

DEVICE=C:\DOS{HIMEM.SYS
DOS=HIGH

FILES=100

. = CAAUTOEXEC.BAT | =1l[=] CAWIN3T{WIN.INI [=1=
SysEdit by  [sroMeT spsg +][[windoves] 7y
. . ISET PATH=C:ADOS;CAUTILS;CAWS 4;CAWINZT;CAGWS lspooler=yes m
selecti ng File IREM the next line was Inserted by PIPEX Dial Version 3.0| [|lload=
IPATH %PATHS%;CADIAL\pctcp tllrun=
and Run from IREM the next line was inserted by PIPEX Dial Version 3.0 .'iﬁﬁ'rif,‘.’.i?«ﬂne
rem SET PATH=%PATH3;CACORELDRY BorderWidth=3
Program rem DOS MAUI - CAMAURSETUPSND.EXE /a330 /19 DALT |[(CursorBlinkRate=530
DoubleClickSpeed=452
ISET TEMP=c}A Programs=com exe bat pif
Manager rem MODE CON CODEPAGE PREPARE=((437) C:ADOS\E] ||Documents=
rem MODE CON CODEPAGE SELECT=437 DeviceNotSelectedTimeout=15
KEYB UK,,CA\DOS\KEYBOARD.SYS MransmissionRetryTimeout=145
L llkeyboardDelay=2 L]
< <
| 1 | 2]
= CACONFIG.SYS ~1=1l=1 CAWINIT\SYSTEM.INI =1

Irem DEVICE=CADOS\EMM386.EXE NOEMS X=cc00-ceft fixedfon.fon=vgafix.fon
DEVICE=C:\DOS\SETVER.EXE fonts.fon=vgasys.fon
display.drv=vgadahtx.drv
rem SHELL=C:\DOS{COMMAND.COM C:\DOS} /e1640 fp Ishell=progman.exe
rem device=C:\dos\RAMDRIVE.SYS 2048 512 256 JE mouse.drv=mouse.drv
rem DEVICE=CSBPROJDRWSBPCD.SYS /D:MSCDO01 {P{ |[inetwork.drv=
language.dii=langeng.dil
Irem ADAPTEC lsound.drv=mmsound.drv
DEVICE=C:\SCSNASPI7DOS.SYS D icomm.drv=comm.drv
IDEVICE=C:\SCSNASPIDISK.SYS /D L llkeyboard.drv=keyhoard.drv LI
< <
A1 13 | K IE3|

] »

+|([boon
38Bgrabber=vivga.3gr

loemfants.fon=vgaoem.fon
28Bgrabber=vgacolrx.gr2

FILE TYPE COMPRESSION
RATIO (X:1)

Zip/GIF 1.0

BMP 1-10

ASCI 2%

Excel/Word 2.4

Programs

(EXE, COM) 1.7

*Depends on content and whether it’s
16,256 or 24-bit colour

ratio doesn’t affect how much DrvSpace
actually compresses the files; it changes
only the way DrvSpace estimates the free
space on the compressed drive. However,
having the wrong estimated compression
ratio for your files can cause DrvSpace to
provide inaccurate space estimates to

DOS, which can, in turn, result in problems
when storing files.

Anyway, we don’t recommend the use
of DrvSpace any longer because hard disk
prices have dropped so low. You can buy a
2Gb IDE drive for just over £160, so why
bother with compression? DrvSpace takes
memory from your 640K, it’s slower to
defragment or to check with Scandisk, and
can affect performance in other ways. And
there may be conflicts with other programs.
Our advice is: hard disk compression out,
larger hard disk in.

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.vnu.co.uk

Personal Computer World ® May 1997 2 6 7




Windows 3.1

The mousetrap

Yes, it’s a good old-fashioned whodunnit: when your mouse trips up while treading the, er,
mat, you can help it get its act together. Panicos Georghiades and Gabriel Jacobs direct.

ith standardisation on Microsoft-

compatible mice, mouse

problems have lessened but
haven’t disappeared. Mice can still fail to

function at all, be too fast, too slow, move in

certain directions and not others, and work
in some programs but not others.

Mouse matters come in threes. There
are three types of mouse: Microsoft,
Microsoft-compatible, and Microsoft non-
compatible; three different ways of
connecting them: via the bus, a PS/2-style
socket, and a serial port; and they can be
used in three types of application:
1. DOS applications, in which case they
usually require a driver loaded in the
config.sys or autoexec.bat files.
2. Windows applications, in which case the
driver is provided by Windows, or a
Windows driver is provided by the mouse
manufacturer.
3. DOS applications running within
Windows.

And, yes, there are three different

Adjusting mouse settings

m Lowering the Sensitivity value in the Mouse
section of Control Panel makes the mouse
movements less jumpy.

m |f the mouse is jumpy in Program Manager
group windows, lower the granularity settings
in the Desktop icon of Control Panel.

m |f you're using the DOS-based mouse
driver mouse.com or mouse.sys version 7.04
or later, add the /Y switch to the end of the
mouse command line

(c:\windows\mouse.com /y)

m Note that erratic mouse movements may
be specific to the application, video card,
machine BIOS, keyboard BIOS, or machine
type you’re using.

When problems strike, are you a man or a mouse? Take valuable advice on failsafe fix-its

causes of mouse problems:

1. Hardware: the mouse isn’t plugged in
properly, it's a bad or unclean mouse,
there’s a bad mouse socket, a bad cable, a
slippery or uneven mouse mat, or the
mouse is connected to the wrong port or
with a wrong or bad adaptor.

2. Bad drivers: an older or incompatible
version is being used.

3. Conflicting software: your mouse driver
may not agree with Windows, or a particular
program, or with some other program
running at the same time like a TSR program,
anti-virus software, or screensaver.

A classic situation is using too many
drivers. Manufacturers provide drivers for
Windows and DOS (and sometimes for
particular DOS programs) and nowadays for
Windows 95. Don’t install them all —

Windows may not run properly if DOS
mouse drivers are also there.

So, if you have a mouse behaving badly,
first check for hardware causes — plug it
into another computer, or plug another
mouse into your computer. Next, establish
that the mouse works in DOS and in
Windows separately. If the mouse doesn’t
work in a DOS application under DOS, it
will not work in that application if you run it
under Windows. Install the DOS drivers
needed in the autoexec.bat and/or
config.sys files, as described in the
mouse’s documentation, and ensure that
all works fine under DOS.

If you have a Microsoft mouse, use
version 8.2 of the driver which comes with
Windows 3.1 and, if necessary, expand
mouse.sy_ and mouse.co_ (they’re on the

p264 [
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Windows disks) to your hard disk as
mouse.sys and mouse.com by using the
EXPAND command at the DOS prompt.
You can test whether all works well using a
DOS program which supports mouse
movements such as Edit. Then disable the
DOS drivers by placing the word REM in
front of the lines referring to them in the
config.sys and autoexec.bat files, and
check the mouse works under Windows.

The Windows mouse drivers are set
using Windows Setup, and they appear in
the system.ini file in the [Boot] section.
Normally there should be a line like
mouse.drv=mouse.drv

To check you have installed the right
Windows driver, exit Windows, change
directory at the DOS prompt to c:\windows,
and type SETUP. If you get a message
saying no mouse has been detected, select
the Microsoft or IBM PS/2 option.

Note that some so-called Microsoft-
compatible mice are more compatible than
others, and you might have to use some
trial and error. In particular, try the drivers
which come with the mouse installation disk
rather than the Microsoft drivers. If all the
above fails, try the following suggestions.

m Search the drive for multiple mouse.drv
files. If you find any, rename them to
something else, except for the one in the
Windows System sub-directory.

m Test the mouse on a different port.

m Check that there’s only one mouse.ini file,
and that the line

MouseType =

in the [Mouse] section of the file points to
the correct port.

m Try running Windows in standard mode. If
all works well, try loading Windows by
typing win /d:x. If all is still okay, add the
following line to the [386Enh] section of
system.ini:

EmmExclude=A000-EFFF

m Finally, if you’re using a mouse that came
with its own drivers, try to borrow a mouse
that uses the driver supplied with Windows.
If that works, contact the manufacturer of
your own mouse.

Out of Africa

“| 'am doing voluntary work in Nigeria, and
have been working on a stock-control and
tracking program using DOS 6.22 and
QBasic (the v4.5 compiler), but the
compiled version of the program gives a
totally incorrect output at the printer — the
numbers are all wrong. Inspecting the code
doesn’t reveal much, as the only difference

lies in an LPRINT statement (to printer) and
a PRINT statement (to screen). There is no
problem with interpreted printed reports or
displayed reports. I've tried two different
printers — no difference. | enclose some
output samples. My big fear is a virus, as
they are rampant here.”

Leigh Bowden, Nigeria

The Microsoft Knowledge Base doesn't list
your problem, but there are a number of
possible causes.

We doubt a virus is the culprit — virus
programmers tend not to target something
as old as QBasic! We assume that you're
not trying to print while running the program
in a DOS session within Windows, as this
doesn’t work with all DOS programs.

The output samples you sent us show
that the text prints fine; only the numbers
are wrong. This obviously implies that the
problem lies in calculations or statements to
do with numeric data only — perhaps a
different set of calculations is being used to
output to the screen than to the printer.
Programmers sometimes attach calculation
statements to PRINT statements, and since
QBasic needs two different statements, one
for the screen and one for the printer, the
set for the printer may contain errors.

Alternatively, it may be that certain
formatting commands used for the printed
output don’t work properly when compiled.
In any case, check you’re using the right
version of the compiler for the version of
QBasic you have, and that you’re setting
the right options for handling numbers for
the compilation. Also, have you checked
the compiler documentation for supported
statements and commands? Some
statements are supported by the interpreter
but not by the compiler.

The write font

A frustrated Bill Reid (mailto:reidw
@nacn.dnet.co.uk) mailed us about being
unable to change the default font in
Windows Write. Each time you start Write,
the default font is Arial: he wants it to be
Times New Roman.

Trying to answer this query has
prompted us to write about a method of
creating templates for Windows Write, to
use for letters, memos, and faxes, a feature
available on all mainstream word processors
but missing from Windows Write.

You can create your own designs and
save them as standard Write documents.
Give them names like letter.wri, memo.wri

A step-by-step guide to creating Write templates

Windows 3.1

and fax.wri. To prevent overwriting the
templates, you have to Save As, not Save,

= Write - FAX.WRI [-]~ . . .
File Edit Find Character Paragraph Document Help and to avoid using Save by m|3take: make
FAX M ESSAG E ij your template files Read Only by changing
their Attributes in the Properties option of
the File menu in File Manager.
TO . To use the templates you open Write,
then use File Open to select a template, or
FROM : . §
you can assign icons to each template so
DATE : you can open them with a double click. To
do this, start Write and the template in one
go by editing Write’s Properties in the File
y menu of Program Manager. In the command
PAGES INCLUDING THIS ONE: . o
line of the Properties dialog box add the
filename of your template, so the command
line reads, for example, write.exe letter.wri.
‘Dem. ____ x Do this for all your templates by clicking
|| and dragging the Write icon while pressing
TR £ the CTRL key to
make copies of
l|=-‘ File Manager |"IA!! . p K
Above Create your templates in Write and save File Disk Iree Yiew Options Window Help it, then editing
them as any ordinary Write documents =] CAWINITY EE each one’s
=l =l [ =d [=e C [PANDC] )
- Clwavepach [+ chold.wav 24962 10/03/92 0310:00 s |*] command line
Right From File Manager make the template files I E1 webputd0 B ding wav 11598 10/03/92 031000  a toinclude a
B3 win31 [2) tadawaw 27804 10/03/92 0310.00 a
Read on|y O meapps sashtwrl G40 07A01/97 024520 a different
£ pistran Iax.wm B40 08/01/97 19:48:00 a
) spstem |2 letterwri 40 D8AT/97 19-33:38 ra template
) ) . . - COwind2app _] mErmo. Wi 640 08/01/97 19:40:00 ra j .
Below Create multiple copies of the Write icon - E1wings Pl | B repottwi B40 DR/N/AT 134010 [ filename.
and edit each one to include the template file El B & E Change the
name in the command line default Write
File N & FAX. WRI .
o i bsies icon to another
Last Change: 08/01/97 19:46:00 one by USiﬂg
5 o C:AWIN31
= Program Item Properties _m ;
- a ibutes - Icons
Description: |fax | | oK i iead Only O Hidden embedded in
lArchive O System
Command Line: WRITE.EXE fax.wri —Ican-:el Progman.exe.
Working Directory: 1 file(s) (640 bytes) [Total 235 filafs) (5,191,148 byies)| To change
the default font

Shortcut Key: |None

| Browsze. .

O Bun Minimized

W2

Change Icon... l

Right You will end up with multiple Write icons,
each one starting a different template

Below To customise your templates even more,
choose a different icon for each one using the
icons embedded in Progman.exe, or any other
icons you may have

from Arial to something else, create an
“empty” template. The only problem is that
the template can’t be completely empty, so

= Program Manager -

|A.

File Options Window Help

you need to
= Program Manager rl&]| teea
File Options Window Help space, say,
+|| thenselect
|| that space
PA PA p” F‘} with the
mouse, and
letter fan memo et from the
Fonts menu
"= change the
e ont to the
font to th
Faintbrush Terrminal Hotepad Recarder E one you
4-{ I | _'!j want.

= Accessories n 2!
& o &
letter TNEMo report
Al H el |
=

Paintbrush Terminal MNotepad Recarder |

+

] ] +*

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabiriel Jacobs at Win3@pcw.vnu.co.uk.
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